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1.1 Objective of this document
The objective of this document is to enable you to create structural steel constructions with
b&w AFX.

It is assumed that you are familiar with the basic functions of Creo Parametric.

1.2 Overview
The Advanced Framework Extension 5.0 (AFX) is an add on software to Creo
Parametric. It simplifies the design of machine frames, structural steel etc. built up with
profiles or plates. All functions of AFX are accessible through the ribbon tab Framework in
Creo Parametric.

For this tutorial you will have to use commands of the Intelligent Fastener 5.0 Ribbon as
well. You can find the required commands in the TOOLS Ribbon.

1.3 Syntax of this guide

Syntax Description

Highlight Important texts

[INPUT] User input or selections

Icons of the software

1.4 AFX Ribbon commands
Image Description

Create new project: Define new AFX project

Project Parameters: Project parameter commands

Rename project: Rename AFX project

Other commands of this group: Various Import and export functions
(STAAD, SDNF)

New Profiles: Profile commands

Reuse:
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Replace

Move

Modify Ends

Modify Type

Modify Size

New Subassemblies: Contains functions for working with project
subassemblies
Reuse: Reuse an existing subassembly

Replace: Replace an existing subassembly

Move:Move an existing subassembly

Basic Joints: Basic profile joint commands

Advanced Joints: Advanced profile joint commands

New Connector Elements: Create new connector element

New Equipment Elements: Create new equipment element

Reuse: Reuse an existing connector or equipment

Replace: Replace an existing connector or equipment

Modify:Modify an existing connector or equipment

Delete: Delete AFX element

Simplified Representations: Contains functions for defining weldment
groups to structure smaller structural assemblies into different weldments

Automatic UDFs: Automatic-UDFs commands

Point Pattern:
Weld Groups: Weld group commands

Create component drawings: Create drawings for subcomponents of current
assembly

Save all component drawings: Saves all component drawings in session

Save selected component drawings: Save selected component drawings

Component Info: Show component information

Online Help:

Edit configuration session: Edit the configuration only for the current
session
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Edit installation configuration: Edit the global AFX configuration

About AFX: Show version information

1.5 IFX Ribbon commands
Image Description

Assemble on point or axis: Assemble a screw fastener on an existing point or
axis

Assemble by mouse click: Assemble a screw fastener on the selected mouse
click position

Assemble on point or axis: Assemble a dowel pin fastener on an existing point
or axis

Assemble by mouse click: Assemble a dowel pin fastener on the selected
mouse click position

Reassemble: Reassemble an existing screw fastener

Redefine: Redefine a screw fastener

Delete: Delete a screw fastener

Check Screw Fasteners: Check all screw fasteners of the current assembly

Update holes: Update Screw Holes

Suppress: Suppress all fasteners

Resume: Resume all suppressed screw fasteners

Options: Edit the configuration options of Intelligent Fastener

Instance Creator: Create instances of the selected files (*.dat)
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2.1 Overview
This chapter explains the basic functions for designing framework with AFX. It is done by
using a simple steel frame, but the used functions also apply for designing frames with
aluminum profiles.

Objectives:

• Understand the design process of AFX
• Define a project
• Assemble straight profiles
• Assemble bent profiles
• Define joints between profiles
• Move profiles
• Replace and modify profiles

2.2 Design Process using AFX
AFX supports a top-down design process of framework assemblies. The following steps are
recommended when designing a framework assembly with AFX:

• Create a datum curve skeleton for the main profiles of the assembly
• Assemble profiles on these datum curves or between points
• Define joints between profiles
• Assemble connector elements between profiles
• Assemble other equipment elements
• Create screw connections

Open the assembly steel_frame.asm in folder steel_frame_start which
already contains a curve skeleton.
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2.3 Define a Project
At the beginning of an AFX design a project needs to be defined, which means you have to
enter a project shortcut (usually the drawing number of the framework assembly). This
shortcut is used by AFX to automatically generate part names.

Hint 1 — Part Names.Without special configuration AFX composes automatically
generated part names as follows:

<PROJECT_SHORT>_<PROJECT_SHORT ELEMENT_NAME>_<ELEMENT_NUMBER>

• PROJECT_SHORT: User defined assembly parameter
• ELEMENT_NAME: The element name depends on the element type (e.g. ENDPLATE)
• ELEMENT_NUMBER: The element number is a counter that increases by 1 every time you

assemble a new element

NOTE:

The project shortcut is stored in an assembly parameter PROJECT_SHORT. If you copy and
rename framework assemblies using Windchill you need to change parameter PROJECT_
SHORT manually to the new drawing number.

More information about configuring naming scheme can be found in AFX online help chapter
Configuring AFX > To Define Component Naming Scheme OR in chapter 8.3.

Define a project for the assembly steel_frame.asm.

Select Create new project to create a new AFX project and enter [sf] as project shortcut.

2.4 Assemble Steel Profiles
Profiles action is subdivided into seven instances:

• New Profile instance to create new parts.

• Reuse. An existing instance will be assembled again.

• Replace. An existing instance will be replaced.

• Move. An existing instance can be regulated by moving position relative to curve or
rotation relative to selected orientation plane.

• Modify Ends. The profile end of an existing instance can be modified.

• Modify Type. The type of an existing instance can be changed.

• Modify Size. The size of an existing instance can be modified.
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Assembling profiles with AFX is done with a dialog box which can be opened by selecting
New Profiles.

The New Profile Dialog:

1. Preview image:

• Shows image of selected profile
• Red cross represents profile reference curve
• Red line indicates the profile orientation plane

2. Profile type.
3. Profile size.
4. Assemble in new subassembly.
5. Material.

Click Next to open the Position Profile dialog box.
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1. Profile size.
2. Reference Method:

• On straight curve

• Between two points or curve/edge end points

• On bend datum curves
3. References.
4. Position relative to curve:

The assembly position is relative to the reference curve, which is left-top, center-top ...
right-bottom.
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The definition of left, right, top and bottom depends on the current view direction on the
assembly.

5. Rotation relative to selected orientation plane:

With the rotation buttons you can set the rotation angles (0° , +90°, -90° or 180°) of the
profile relative to the profile orientation plane.

6. Filename.

Assemble a New Instance of a Profile on a Straight Datum
Curve
To assemble a new instance of a profile (e.g. rectangular tube DIN 2395 120x80x4) on a
datum curve of the assembly steel_frame.asm perform the following steps.

1. Click New Profile to open the New Profile Dialog box. The first time you open the
dialog you will be forwarded to Select from library dialog automatically.

2. Click to open the Select from library dialog box. Here you can select the profile
group (e.g. steel profiles in mm, Bosch, etc.) and the profile section type.

3. In this case select [STEEL BEAMS MM] and the [RECTANGULAR TUBE]

As the rectangular tube is available in different standards and sizes the Element
definition dialog box for selecting a standard and size opens.
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After selecting the RECTANGULAR TUBE the Element definition dialog box will
automatically open.

You can also open this dialog within the Profiles dialog by clicking .

In this example select:

[TYPE: DIN 2395]

[SIZE: 120x80x4.00

4. Click [OK] to close the Element definition dialog box.
5. Click [Next] to open the Position Profile dialog box.
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6. Select the horizontal front curve [A] like shown in the picture.

• A new profile part will be assembled on the curve as a preview with an automatically
selected orientation plane.

7. To define the orientation of the profile around the reference curve you have two options:

• To rotate the profile click one of the buttons , , , or click and

enter the rotation value into the input panel. In this example click so the profile
will be oriented like shown in picture.

or

• Make sure that the Orientation plane reference collector is active and then select
another planar surface or datum plane as orientation plane (parallel to the long red line
in the section preview picture). Take care that the plane is parallel to the curve/edge. I.
e. you could select the datum plane A_XY [B].

8. Click [Repeat] to permanently assemble the profile and continue with placement of next
profile..

9. Select the left vertical curve [C].

• Another profile with active section will be assembled.
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Take care that the active plane (selected last and highlighted in green) is parallel to the
curve/edge you want to select. If it is not parallel, select a new plane first, then select
the desired curve.

10. Click to rotate profile by 90 degrees so it is oriented like shown in picture and then
[Repeat].

11. Now select the left upper curve [D] and then the datum plane A_YZ as new orientation
plane [E].

• A new rectangular tube will be assembled.

12. Click to rotate profile by 90 degrees so it is oriented like shown in picture and then
[Repeat].

13. Now select the upper right curve [E].

• Another rectangular tube will be assembled as new part.

14. Click to rotate profile by 90 degrees so it is oriented like shown in picture and then
[OK] to close the dialog.

In the model tree you see that every profile is a unique part and their names are made as
follows.
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• project shortcut – SF
• the profile type – RECTANGULAR_TUBE
• an incremental number – 1

In front of every profile part is a group PROFIL_REF_CSYS. It contains a coordinate
system on which the profile part is assembled. The coordinate system contains offset
dimensions to the first coordinate system of the group by which the profile can be moved or
rotated relatively to the curve.

The section size of every profile can be shown as 3D-note if you unhide the layer 00_
PROFIL_SIZE_NOTE.

Assemble an Existing Instance of a Profile on a Straight Datum
Curve
To reassemble an existing profile proceed as follows.

1. Click the Reuse button to open the reuse profile dialog box.
2. Select the existing profile part you want to assemble again. In this example select the front

horizontal profile SF_RECTANGULAR_TUBE_1.PRT [A].

OR

1. Select the Profile SF_RECTANGULAR_TUBE_2.PRT.

2. Press the right mouse button and select Framework > Reuse
3. Click [Next] to open the Position Profile dialog box.
4. Select the back horizontal curve [B] as profile reference curve.

5. Click to rotate profile by 90 degrees so it is oriented like shown in picture and then
[OK].
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6. The reuse profile dialog box appears again. Make sure that the Profile to Reuse reference
collector is active and select the left vertical profile SF_RECTANGULAR_TUBE_1.
PRT [D] to assemble this profile on other curves.

7. Click [Next] and select the vertical outside curve [E], rotate profile and click [Repeat] or
middle mouse button to complete profile placement. Repeat the procedure with outside
curves [F] and [G].

• The same Creo Parametric part will be assembled on the three curves.

Hint 2—Right mouse button. You might have realized, that many of the AFX functions
have found their way into the right mouse button menu.

Assemble Profiles between Two Points
Straight profiles can also be assembled between two datum points or curve/edge end points. It
is possible to create these points on the fly with Creo Parametric when AFX prompts you to
select them.

In this example a rectangular beam DIN 1017 80x40 shall be assembled between two curve
end points.

1. Click New Profile to open the New Profile dialog box.

2. Click and select [STEEL BEAMS MM] > [RECTANGULAR BEAM].
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3. In the Element Definition dialog box select:

• [TYPE: DIN 1017]
• [SIZE: 80x40]

4. Click [Next]. The Position Profile dialog box opens.

5. Click to activate the between two points reference method.
6. Select the two curve end points [A] and [B] as shown in next picture.

• The rectangular profile will be assembled.
7. Click [OK] to close the dialog box.

Assemble Bent Profiles on Curves
With AFX you can assemble profiles on planar bend datum curves. It is possible to assemble
profiles on a from-to curve chain or a complete curve chain. There are some limitations:

• All segments of the curve must be in one plane.
• The bent profile must be open.
• The start and end point may not align.
• For bent profiles only the following Instance types are supported

○ Assemble new profile instance

○ Reuse profile as same instance
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In this example a RECTANGULAR BEAM DIN 1017 25x10 shall be assembled on the left
front curve chain.

1. Click New Profile and make sure that the RECTANGULAR BEAM in the STEEL
BEAMS MM folder is still active.

2. Click to open the Element definition dialog box and select:

[TYPE: DIN 1017]

[SIZE: 25x10]
3. Click [Next]. The Position Profile dialog box opens.

4. Click to activate the Reference method Assemble profile on a bent curve

5. Select the start curve segment for the profile on the curve chain [A].
6. Select the end curve segment for the profile on the curve chain [B].

• The bent profile will be assembled between start and end curve segment on the chain.
• The orientation plane will be selected automatically
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7. Click [OK] to close the dialog box.

Reassemble this profile as identical part on the left bend curve chain.

8. Click to reassemble an existing profile instance.
9. Select the profile assembled previously SF_RECTANGULAR_BEAM_5.PRT [A].
10. Select the upper curve segment of the left bent curve as start curve segment [B] and the

lower curve as end curve segment [C] for assembling the profile again.

• The bent profile will be assembled as identical part.

Pattern Profiles
Profiles assembled with AFX on patterned reference curves can be reference patterned with
standard Creo Parametric functionality. However it is necessary to use a special technique.
Proceed as follows.

First assemble a RECTANGULAR BEAM DIN 1017 100x50 like shown in the picture
using the functions described in 2.4.1. The datum curve on which the profile is assembled is
patterned.

In Creo Parametric model tree make the features visible. You see the group PROFILE_
REF_CSYS in front of each profile. These groups contain some datum points and coordinate
systems. The profile is assembled on the second coordinate system.
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As the profile references on the 2nd coordinate system of the group, creating a reference
pattern of the profile has to be done in two steps. First you have to create a reference pattern
of the PROFILE_REF_CSYS group and then you can create a reference pattern of the
profile itself.

1. Select the group PROFILE_REF_CSYS_8 in front of the profile in model tree with
right mouse button and select Pattern.

2. Select pattern type [Reference] and click .

• A reference pattern of the group is created. Now the profile references on a patterned
element (the coordinate system of the patterned group) and it is possible to create a
reference pattern of the profile.

3. Select the profile part SF_RECTANGULAR_BEAM_6.PRT in the model tree with the
right mouse button and select [Pattern].

4. Select pattern type [Reference] and click .

• A reference pattern of the profile is created.
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2.5 Define Joints between Profiles
When assembling profiles with AFX they are assembled with the length of the reference
curve and cut perpendicular to the reference curve. To design the connection points between
profiles there are several functions for defining joints. You can define corner joints, mitre
joints, T-joints, etc. You also can cut profiles using the geometry of other profiles, create
additional planar cuts on profiles and create replace surface joints to join surfaces of non-
profile parts to other planar surfaces. The definition of joints with AFX is done with two
dialog boxes: Basic Joints and Advanced Joints.

To open Basic Joints press Basic Joints in the framework ribbon.
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1. Joint Actions
2. Blank/unblank joint symbols
3. Corner Joints

• both profile ends are modified
4. Mitre joints

• both profile ends are modified
5. T-joints

• Only the 1st profile end is modified
6. To selected surface

• Only the 1st profile end is modified
• The 2nd part doesn’t have to be a profile

7. Join Datums.
8. With or without offset.
9. References.
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To open Advanced Joints press Advanced Joints in the framework ribbon.

1. Joint Actions.
2. Cutout.

• Cut profile or other part with the shape of a profile
• Uses external references

3. Planar Trim.

• Cut profile or other part with a planar surface
• Uses external references

4. Replace Surface.

• Cut/extend profiles
• Uses external references

5. Input panels for offsets.
6. References.

Hint 3 — Overwrite Joints. If you want to modify or redefine a regular joint (defined by
one of the 12 buttons of basic joints) just create a new joint and accept the query whether you
want to overwrite the old joint.

If you want to modify a profile cutout or planar trim delete it and create it again.
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The important advantage of regular joints compared to a profile cutout or planar trim is that
AFX automatically locates the proper attachment surface in most cases and that external
references are avoided. AFX just modifies dimensions in the coordinate systems CS_S

and CS_E within the profiles.

Always use regular joints as long as profile ends are cut planar.

Create Corner Joints
By defining a corner joint with AFX you can design a corner so one profile end overlaps and
the second attaches or both profile ends overlap or the corner area itself remains free.

1. Click to define a corner joint in Basic Joints dialog box.
2. Make sure that First profile reference collector is active and select the first overlapping

profile near its end [A].
3. Make sure that Second profile reference collector is active and select the second attaching

profile near its end [B].

The joint is created as a preview.
4. Click [Repeat] to apply and reuse the current joint type.

• The joint is created permanently and a joint symbol is displayed which looks like the
joint.

Now create another corner joint at the rear left corner. As the rear horizontal profile is the
same part than the front horizontal profile you see its profile end already is modified. You also
can see this at the joint symbol which looks like half of a joint symbol which is already
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controlling this profile end. Anyhow you can create the joint, but be aware that both joint
definitions should result in same shape of the profile end (i.e. do not make a corner joint at
one place and a mitre joint at the other place).

Create Mitre Joints
The creation of mitre joints is done similar to corner joints.

1. Click in the Basic Joints dialog box.
2. Select the first profile near its end [A].
3. Select the second profile near its end [B].
4. Click [OK]

• The mitre joint is created and a joint symbol is displayed which looks like the joint.

As the rear horizontal profile is the same part than the front horizontal one, the mitre cut
also appears on the rear profile [C]. Unfortunately the cut has same orientation as on the
front profile, which means on this place it has wrong orientation. The profile needs to be
rotated by 180 degrees. Therefore AFX has functions to move or rotate profiles (see also
chapter 2.6).

To rotate the rear profile and then create the mitre joint proceed as follows.

5. Press Move in the Profiles group.
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6. Click to rotate profiles by 180 degrees.
7. Select the rear horizontal profile [D].
8. Click [OK] in selection dialog. The profile is rotated by 180 degrees.

9. Now open Basic Joints dialog box again.

10. Click in Basic Joints dialog box.
11. Select the first profile end [E].
12. Select the second profile end [F].
13. Click [OK]

• The mitre joint is created.

Create T-Joints
While corner joints and mitre joints modify both profile ends, a joint from type T-joint only
modifies one profile end. You can use them if

• a profile end needs to be attached to a profile side surface
• more that two profiles meet at one point and between two of them a corner or mitre joint

is already defined.

1. Click in Joints dialog box.
2. Select the rear profile end of the rectangular beam [A].
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3. Select the rear horizontal rectangular tube [B].

• The T-joint is created as a preview.
4. Click [Repeat] to apply and reuse the current joint type.
5. Select the front profile end of the rectangular beam [C] and the front rectangular tube [D]

to attach the other side as well.

• The T-joint is created as a preview. As the profile is patterned the pattern instances are
modified too

6. Click [Repeat] to apply and reuse the current joint type.
7. Select the front vertical profile [E] and the front horizontal profile [F] to fit the vertical

profile as third profile into the existing corner.
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• As this profile is assembled four times the other three instances are shortened, too.

8. Click [Repeat] to apply and reuse the current joint type.
9. Select the lower end of the diagonal profile [G] and the right vertical profile [H] to attach

the diagonal profile on its lower end and click [Repeat].
10. Select the upper end of the bent profile [I] and the front horizontal profile [K] to attach

the bent profile on its upper end and click [Repeat].

11. Select the upper end of the bent profile [L] and the front vertical profile [M] to attach the
bent profile on its upper end and click [Repeat].

12. Repeat this step with the lower end of the bent profile [N] [O].
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• As the bent profile is assembled as existing instance at the left rear side, the profile
ends are modified on this instance as well.

Hint 4 — Joints at reuse places. If you have assembled profiles as existing instance
multiple times try to define the joints at the first assembly place. Define joints at reuse places
only if necessary.

Exercise
Complete the frame with SQUARE TUBES DIN2395 80x80x4.0 and U-BEAMS DIN1026
U80 like shown in the next picture. Create the necessary joints. The upper horizontal profiles
are hidden in the picture.

1. Assemble one [CHANNEL BEAM DIN 1026 U80] as new profile instance on the
vertical middle front curve [A1], and then this profile as reused instance on the vertical
middle rear curve [A2].

2. Assemble one [SQUARE TUBE DIN 2395 80x80x4] as new profile on the lower left
front curve [B1] and then this profile as reused instance on lower left rear curve [B2].

3. Assemble one [SQUARE TUBE DIN 2395 80x80x4] as new profile on the lower right
front curve [C1] and then this profile as reused instance on lower right rear curve [C2].
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4. Assemble one [SQUARE TUBE DIN 2395 80x80x4] as new profile between the two left
end points of the lower horizontal curves [D1] and then this profile as reused instance
between the two right end points of the lower horizontal curves [D2]

• HINT: Switch to wire frame display and select by query which makes it easier to
select the curve end points).

5. Create the necessary T-Joints at the first assembly positions of each profile.

Creating Joints to Selected Surfaces
Joints from type corner joint, mitre joint or T-joint usually find the proper attachment
surfaces automatically. If this is not the case or you want to create a joint to a surface of a non
profile part you can use the joint type selected surface. This joint allows you to select the
desired attachment surface for the profile end. Zoom to the place where the lower left square
tube and the U-beam meet. You see that the square tube does not extend to the inner surface
of the U-shape, but just to the bounding box of the U-beam.

Now extend the square tube to the inner surface of the U-beam.

1. Click in Basic Joints dialog box.
2. Select the lower left square tube near its right end [A].
3. Accept the prompt overwrite the existing joint.
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4. Select the inner surface of the U-beam [B].

• The square tube is attached to the selected surface but not cut with the U-shape.
5. Click [OK] to apply and close dialog box.

Creating Profile Cutouts
1. Check [With offset] in Advanced Joints dialog box for a profile cutout with offset.

2. Enter the offset value in the input field right to [2.0].

3. Click for a profile cutout with offset.
4. Select the square tube to cut out [A].
5. Select the reference profile (U-beam) for cutout [B].

• The profile cutout is created.
6. Click [OK] to apply and close dialog box.
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Hint 5 — Joint references. Unlike regular joints (corner joint, mitre joint etc.) a profile
cutout creates an external reference to the other profile.

Create a Planar Trim
In some cases (e.g. the lower right end of the diagonal profile) a profile is cut with two or
more planar cuts. In this case first create a regular joint (T-joint, Selected Surface joint) then
create a Planar Trim for the second cut.

1. Click in Advanced Joints dialog box for a planar trim.
2. Select the rectangular beam to cut [A] at a position which shall be kept after cutting.
3. Select the plane which shall be used for cutting [B].

• The profile will be cut at this plane.
4. Click [OK] to apply and close dialog box.
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Hint 6 — Delete special Joints. Unlike regular joints (corner joint, mitre joint etc.) a planar

trim creates an external reference to the other profile. A profile cutout can be deleted with
. Be sure to select the surface that has been modified by the joint.

Create Joints to Selected Surfaces with Normal Cut
If a profile end shall be attached to a surface at an angle, in some cases the profile end surface
is not attached directly to this surface, but is cut normal to profile length axis and only the
profile end surfaces edge touches the attachment surface.

1. Click in the Basic Joints dialog box, to create a joint of type selected surface
with normal cut between the upper left end of the diagonal profile and the upper
horizontal rectangular tube.

2. Select the diagonal profile at the upper side surface near the upper left end [A]. Accept the
prompt overwriting the existing joint.

3. Select the upper horizontal rectangular beam at its bottom surface [B].

• The diagonal profile is cut normal to its length axis along the intersection line between
the two selected surfaces.

4. Click [OK] to apply and close dialog box.
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For further exercises in this training guide overwrite the just defined joint by a regular T-joint
as described in chapter 2.5.3.

2.6 Move Profiles
Usually profiles are assembled with their center aligned to the reference curve and oriented to
the orientation plane. Later on they can be moved or rotated. This can be done in the Profiles
dialog in the tabMove.
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1. Move commands

• Move by mouse pick

• Align with other profile entity

• Reset profile movement
2. Move to predefined positions
3. Move by values
4. Rotate profiles
5. Switch start and end

Rotate around Profile Axis
Besides rotating profiles when assembling them, they can ne rotated later on when joints
already are defined.

1. Select the highlighted profiles [A].

2. Click inMove Profile dialog box.
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3. Select the highlighted profiles [A].
4. Click [Repeat] or middle mouse button.

• The profiles are rotated and adjusted in length according to their joint definitions.

Rotate Profiles to Switch Profile Start and End on the Curve
Two cases make it necessary to switch profile start and end on the reference curve:

• You assemble a non symmetric profile (e.g. unequal angle) and the desired position can
not be set just by rotation around the curve. It requires a mirroring of section geometry
which is switching profile start and end on the reference curve.

• You have assembled an existing profile instance again and on the reuse place profile cuts
(i.e. holes, cutouts etc) appear on wrong profile end, so you need to switch start and end.

1. Select the left rear square tube [A]. This is assembled as existing instance of the left front
square tube. As the front square tube got a profile cutout using the U-profile, the cutout
also appears at the rear reuse place.

2. Click .

• The profile start and end is switched on the curve, the cutout appears on the other side.
3. Click [Repeat] or middle mouse button.
4. Select the left rear square tube [A] again.
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5. Click ofMove dialog box.

• The profile is switched back to its original position.
6. Click [Repeat] or middle mouse button.

Move Profiles by Mouse Pick
With AFX you can move profiles by selecting a surface or edge so that the selected surface or
edge is aligned with the profile reference curve.

1. Select the four upper rectangular tubes on their upper surface [A].

2. Click inMove group ofMove Profiles dialog.

• The four profiles are moved perpendicular to the selected surfaces and the reference
curve is aligned with the surfaces.

3. Click [Repeat] or middle mouse button.
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Hint 7 — Move profiles multiple times.With this method you can also move profiles

multiple times with different surface selections. Use to undo the profile movement.

Move Profile to other entity
Using AFX you can move profiles to surfaces, edges or points of other profiles or parts.

1. Select the two left vertical rectangular tubes on their outward surfaces [A].

2. Click ofMove Profile dialog box.
3. Select the outward surface of the left upper rectangular tube [B] as reference surface, to

which the other profiles shall be moved.

• The two profiles are moved perpendicular to the surfaces so that the selected surfaces
of the profiles are aligned with the selected surface.

4. Click [Repeat] or middle mouse button
5. Repeat the procedure on the right side of the frame.
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Move Profile to Predefined Position
Using AFX you can move profiles to predefined positions (e.g. left-top, right-top, left-
bottom) relative to the reference curve. The definition of left, right, top and bottom depends
on the current view direction you look at the assembly. This means that using the same button
you get different results depending from which direction you look at the assembly. If a profile
runs nearly parallel to the screen the definition of left, right, top and bottom may be not clear,
therefore this function sometimes moves the profiles not as desired. In this case rotate the
assembly (different view direction) or use a different function for moving.

1. Select the rectangular profile [A].

2. Click .

• The profile is moved so its upper left edge aligns the reference curve.

3. Click .

• The profile is moved so that the reference curve aligns the upper center of the profile.
As the profile is patterned, the pattern instances are moved as well.

4. Click [OK] to accept and close dialog box.
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2.7 Modify and Replace Profiles
With theModify commands you can:

• modify profile sections
• replace profile sections
• move profile ends relative to the reference curve.

Now click to openModify Ends in Framework ribbon.

Modify profile ends

• Modify profile end using dimension

• Make profile end the same as another profile end

• Reset profile end

If you click to openModify Type in Framework ribbon, you will be able to change the
type of profile.

If you click to openModify Size in Framework ribbon, you will be able to change the size
of profile.
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Modify Profile Section
As described in 2.7.0 two cases appear when modifying profile sections:

• Modify section size of same section type AFX keeps Creo Parametric model and just
modifies the section dimensions. Holes and cuts made in the profile are kept.

• Modify to different section type AFX creates a new Creo Parametric model. Holes and
cuts made in the profile are lost.

To Modify section size of the diagonal profile from 80x40 to 120x40 proceed as follows:

1. Click to open theModify Size command in Profiles group.
2. Select the diagonal rectangular beam [A] as reference.

3. Click .
4. Select [DIN 1017 120x40].

• The dimensions of the section and BOM parameters are modified because the profile
has the same section type. The modification is shown as a preview.

5. Click [OK] to accept modification and close dialog box.

To modify section of the diagonal RECTANGULAR BEAM DIN 1017 120x40 to a
UBEAM DIN 1026 U100 proceed as follows:

1. Click to open theModify Type command in Profiles group.
2. Select the diagonal rectangular beam [A].
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3. Select a [CHANNEL BEAM] [DIN 1026 U 100].

• The rectangular beam is replaced by an U-beam. The U-beam is a new part, additional
holes or cuts created in the rectangular beam (i.e. the planar trim) are lost. The resulr
is shown as a preview.

4. Click [OK] to accept modification and close dialog box.

Hint 8 — Replace profiles. If the replaced profile sections fails, check whether the profile
has children in the current assembly. If yes, suppress the children, replace the profile section
and then resume the children. In some cases you need to redefine the placement of the
children.

Replace Profiles
Click on Profiles group to open Replace Profile dialog box.

The following functions allow the replacement of profiles:

• Replace profile by an already assembled profile

• Replace profile by a copy of an already assembled profile

• Replace profile by a copy of the section of an already assembled profile

• Replace profile by a copy of itself

For example if you want to create holes in just one of the four identical vertical rectangular
tubes, you have to replace this profile by a copy of itself (which creates a new part as copy of
the existing). Afterwards you can create the holes in this part.



Replace Profiles

Page 46/136

1. Click in Replace Type area of dialog box.
2. Select the rear right rectangular tube [A].

• A copy of the selected profile is assembled at the selected location (a new part with
new name appears in model tree) as a preview..

3. Click [Repeat] or middle mouse button accept modification.

If you copied a profile by mistake you can undo the procedure above (as the different profiles
need to be the same parts again). Proceed as follows.

1. Click in Replace Type area of dialog box.
2. Select the front right rectangular tube [A] as existing profile by which the others shall be

replaced.
3. Select the rear right rectangular tube [B].

• The rear right rectangular tube will be replaced by the selected profile, the vertical
profiles on all four sides of the frame are identical parts again.

4. Click [OK] to accept modification and close dialog box.
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Modify Profile Ends
Click on Profiles group to openModify Ends dialog box.

The following functions allow modifying the profile end surface relative to the end of the
reference curve.

• Modifying profile ends by entering offset dimension, X- and Y-rotation angle in the
input boxes or by modifying the dimensions on the model.

• Copying the modification of a profile end to another profile end.

• Reset profile end.

To extend the left front rectangular tube 100mm and cut it in 45° proceed as follows.

1. Click onModify tab of Profiles dialog box.
2. Select the lower end of the rectangular tube [A].

• The current profile end dimensions appear on the model and in the input boxes of the
dialog box.

3. Enter the desired values in the input boxes [100] for the offset and [45] for the left angle
like shown in the picture.

4. Press [enter] or the middle mouse button.

• The profile end will be modified. Now reset the modification again.

5. Click in the dialog to reset the changes.
6. Select the profile end again [A].
7. The profile end dimensions will be reset to 0.
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Hint 9 — Modify profile ends. Take care that the profile end you want to modify is not
controlled by a joint otherwise the joint will overwrite your settings after regenerating the
assembly.
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3.1 Overview
The library of AFX contains a lot of connector and equipment elements for structural steel
and aluminum profiles. When assembling these elements with AFX, not only the components
are assembled, but also the necessary modifications (cutting the profile, creating holes, . . . )
are made. These elements can be accessed by the Connector elements dialog box or by the
Equipment elements dialog box. Both dialog boxes are similar they just access different
areas of the library.

To open the Connector elements dialog box click New Connector Elements.

1. Preview image
2. Choose connector

Connector and Equipment Elements

All connector and equipment elements of AFX library (especially for structural steel) have an
element specific configuration dialog box, in which you can make the desired configuration
settings and which assists you in selecting the necessary references. As the different elements
need different settings and references, all configuration dialog boxes are different. However
they have a common look and feel and consist of the same dialog elements. You should
always use them in the same way. The structure of a element configuration dialog box is
shown in the following pictures.

Tab 1: References selection
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Tab 2: Definition of settings, dimensions and options
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Other functions of the Element Definition dialog are:

• Measure in Creo Parametric (diameter, distance, length)

Use these dialog boxes with following procedure:

1. When the dialog box opens for creating an element the References tab is active. Look at
the picture to understand necessary placement references (marked by numbers).

2. Define Required references and Optional references: Look in the picture for the
number in brackets which can be found in the references area and think about which
reference of your model corresponds with the picture.

3. Make sure that the desired reference collector is active and select the reference. The
selected reference also is highlighted in the model.

4. Repeat step 3 for all required references.
5. Optional references: If required also repeat step 3 for optional references.
6. Toggle to the Settings tab. Look at the picture to understand dimensions and options

(marked by letters).
7. If tables are available in the lower area of the dialog box, perform the table selections. The

table headline shows you what you can select. Perform all table selections - no table
should remain unselected.
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8. Options: If options are available check the required options. The meaning of options is
described by the text and picture.

9. Enter values: If input boxes are available enter the desired dimensions or parameters. The
meaning of dimensions are described in the picture. If you see a «?» in the box no value is
specified. You can overwrite default values. If a ? in a box changes after performing a
table selection this box is controlled by table values. You can overwrite these values after
performing all table selections. If you select a table after overwriting such a value it will
be set to the default from the table.

10. Click [Preview] to create the element as a preview.
11. Click [OK] after completing the configuration.

• The element will be assembled.

3.2 Assemble new Connectors
When assembling a new instance of a connector element, a new part is copied from library
and assembled. In this example, an end plate shall be assembled.

1. Click to open Select from library dialog box for selecting a connector element.
2. Select [STEEL CONSTRUCTION MM] > [NONSTANDARD] and then the element

[END PLATE].

3. The element definition dialog box opens with References tab active.



3.2 Assemble new Connectors

Page 54/136

4. Make sure that the [Profile top (1)] reference collector is active and select the side surface
of the right front rectangular tube near the profile end [A]

5. Make sure that the [Attach face (2)] reference collector is active and select datum plane
A_XZ [B].

6. Toggle to Settings tab.
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7. Check option [Holes (A)] to create the end plate with holes.
8. Keep the default values for plate size.
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9. Click [Preview] or middle mouse button to get a preview..
10. Click [OK] or middle mouse button.

• The end plate will be assembled as new part and the profile is cut.

3.3 Reassemble Connectors
An already assembled connector element can be assembled again as identical part. In this
example the previously assembled end plate shall be assembled at the end of the three other
vertical rectangular tubes.

1. Click in Components group.
2. Select the end plate assembled in previous chapter [A].
3. Press [Next] or middle mouse button. The element definition dialog box opens with

References tab active.
4. Make sure that the [Profile top (1)] reference collector is active and select the side surface

of the left front rectangular tube near the profile end [B]
5. Make sure that the [Attach face (2)] reference collector is active and select datum plane

A_XZ [C].
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6. Click [Preview] or middle mouse button to get a preview.
7. Click [OK] or middle mouse button.

• The end plate will be reassembled and the profile is cut.

Now assemble the end plate on the other two vertical rectangular tubes.
8. Click [Next] or middle mouse button in the Reuse Component dialog box.
9. Repeat step 4 to 7 and select side surface of rear right rectangular tube near the profile end

[D] as Profile top and datum plane A_XZ [E] as Attach face.

• The end plate is assembled at the rear right rectangular tube.
10. Click [Next] or middle mouse button in the Reuse Component dialog box.
11. Repeat step 4 to 7 and select side surface of front right rectangular tube near the profile

end [F] as Profile top and datum plane A_XZ [E] as Attach face.

• The end plate is assembled at the front right rectangular tube.
12. Click [Close] in the Reuse Component dialog box to quit the process.
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.

3.4 Reassemble Connectors as Copy
If you have made modifications at an assembled connector element (e.g. created additional
features) and want to assemble the connector element at another location including these
modifications but different dimensions, it is common practice to assemble the connector
element as copy of an existing connector element.

1. Using standard Creo Parametric functionality, create 4 rounds at the 4 edges of the
previously assembled end plate [A].

2. Open the Reuse Component dialog box with Reuse.

3. Click to assemble a copy of an existing instance of a connector element.
4. Select the end plate which you want to assemble as copy [A].

• The Copy Component Definition dialog box opens. It allows you to define a name
for the copied component. In this case leave the default value.

5. Click [OK] to close the dialog and to continue the process. The element definition dialog
box opens with References tab active
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6. Select the side surface of the middle front U-beam near its end [B] as Profile top and
datum plane A_XZ [C] as Attach face.

7. Click [Preview] or middle mouse button to get a preview.
8. Click [OK] or middle mouse button.

• A copy of the end plate will be assembled. Now it can be modified.

3.5 Modify Connectors
With this function you can modify the size of a connector element including the dimensions
of cuts, holes etc. which are created together with the element. However redefining placement
references is not possible.

1. Click in Components group.
2. Select the end plate which was assembled as a copy in previous chapter [A].

• The Element definition dialog box for the end plate opens with the Settings tab active.
The References tab is not visible.

3. Modify the values for H to [150], T to [30] and H1 to [100] like shown in next picture.



3.5 Modify Connectors

Page 60/136

The values H1 andW1 control a datum point feature with four points (on blanked layer
00_SCREW_POINTS). These points can be used for the placement of fasteners later

on.
4. Click [Preview] or middle mouse button to get a preview.
5. Click [OK] to close the Element definition dialog box.

The end plate is modified and the U-beam is adjusted to the new plate thickness.
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3.6 Replace Connectors by Copy of Itself
With this function you can replace a connector element by a copy of itself. This is required if
a connector element, which previously was assembled as identical model, needs to be
different now.

1. Click in Components group.
2. Select the end plate at the front right vertical profile, which was assembled as a copy in

previous chapter [A].
3. The Copy Component Definition dialog box opens. Accept the default name of the

copied plate part by pressing [OK].

• The end plate is replaced by a new model which is a copy of the previous model. Now
it can be modified, e.g. delete the rounds at the corner or modify size.

3.7 Assemble typical Connector Elements
This chapter describes some other typical connector elements for steel profiles.
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Assemble a Single Angle Connection

1. Click to open Select from library dialog box for selecting a connector element.
2. Select [STEEL CONSTRUCTION MM] > [NONSTANDARD] > [1 ANGLE].

• The Element definition dialog box of the single angle opens on References tab.
3. Make sure that the Profile side face reference collector is active and select the profile side

surface of the lower left square tube [A].
4. Make sure that the Attach face reference collector is active and select the side surface of

the left rectangular tube [B].
5. Toggle to the Settings tab.
6. Select angle size [DIN 1028 L 40x4] from table.
7. Enter the desired angle length [80] in input field L.
8. Enter the desired offset value between profile end and attachment surface in the input field

C. In this example enter [0].
9. Click [Preview] or middle mouse button to get a preview.
10. Click [OK] or middle mouse button to close the Element definition dialog box.

• The angle is assembled and the profile shortened, if necessary.
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Assemble a Plate in a Rectangular Corner

1. Click to open Select from library dialog box for selecting a connector element.
2. Select [STEEL CONSTRUCTION MM] > [NONSTANDARD] > [RECT CORNER

PLATE].

• The Element definition dialog box of the end plate opens on References tab.
3. Make sure that the Profile end reference collector is active and select the side surface of

the lower right square tube [A].
4. Make sure that the Attach face reference collector is active and select the side surface of

the right rectangular tube [B].

• Usually the plate is assembled centered to the profile selected at Profile end. Optional
you can select a profile side surface to align the bracket to this surface.

5. In this example Make sure that the Profile side face reference collector is active and
select the side surface of the diagonal rectangular beam [C].

6. Toggle to the Settings tab.

7. Enter desired length [200] in field L.
8. Enter desired height [200] in field H.
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9. Click [Preview] or middle mouse button to get a preview.
10. Click [OK] or middle mouse button to close the Element definition dialog box

• The plate is assembled. If necessary you can modify the plate with regular Creo
Parametric functions and assemble it as existing element or copy of existing element
on other locations of the assembly.

Assemble a Triangular Corner Plate in a Rectangular Corner

1. Click to open Select from library dialog box for selecting a connector element.
2. Select [STEEL CONSTRUCTION MM] > [NONSTANDARD] > [TRIANG

CORNER PLATE].

• The Element definition dialog box of the end plate opens on References tab.
3. Make sure that the Profile end reference collector is active and select the side surface of

vertical left rectangular tube [A].
4. Make sure that the Attach face reference collector is active and select the side surface of

upper horizontal rectangular tube [B].
5. Toggle to the Settings tab.

• Enter desired values for bracket size. In this example keep the default values.
6. Click [Preview] or middle mouse button to get a preview.
7. Click [OK] or middle mouse button to close the Element definition dialog box.
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• The corner plate is assembled.

3.8 Assemble typical Equipment Elements
In this chapter some typical equipment elements for steel profiles are explained. They work
similar to connector elements, however they are accessible by different menu buttons and a
different dialog box.

To open the Equipment elements dialog box click New Equipment Elements.

Assemble a Profile End Cap

1. Click to open Select from library dialog box for selecting a equipment element.
2. Select [STEEL CONSTRUCTION MM] > [BEAM END PLATES] > [END PLATE

RECT].

• The Element definition dialog box of the end cap opens on References tab.
3. Make sure that the Profile end reference collector is active and select the side surface of

the rectangular tube [A].
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4. Toggle to the Settings tab.

• Enter desired values for cap size. In this example keep the default values.
5. Click [Preview] or middle mouse button to get a preview.
6. Click [OK] or middle mouse button to close the Element definition dialog box.

• The end cap is assembled.

Assemble a General Rectangular Plate Element
This element can be used as general element for rectangular plate elements (e.g. cover plates,
table plates etc.).

1. Click to open Select from library dialog box for selecting a equipment element.
2. Select [PLATES MM] > [PLATE].

• The Element definition dialog box of the PLATE opens on References tab.
3. Make sure that the Left Plane reference collector is active and select the left profile side

surface of upper left rectangular tube [A].
4. Make sure that the Right Plane reference collector is active and select the right profile

side surface of upper right rectangular tube [B].
5. Make sure that the Bottom Plane reference collector is active and select the front profile

side surface of front horizontal rectangular tube [C].
6. Make sure that the Top Plane reference collector is active and select the rear profile side

surface of rear horizontal rectangular tube [D].
7. Make sure that the Attachment plane reference collector is active and select the upper

profile side surface of front horizontal rectangular tube [E].
8. Toggle to the Settings tab.
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9. From table select Attach option [A] to place the plate on top of the Attachment plane (B
= centered, C= aligned).

10. Enter desired plate thickness [20] in field T.
11. Enter desired offset values [20] in the four fields OFF_LEFT, OFF_RIGHT , OFF_

BOTTOM and OFF_TOP.
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12. Click [Preview] or middle mouse button to get a preview.
13. Click [OK] or middle mouse button to close the Element definition dialog box.

• The plate is assembled.
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4
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4.1 Overview
AFX also includes a full version of Intelligent Fastener (IFX). It is a very powerful tool to
define screw and dowel pin connections and is delivered with a big library of standard parts
such as screws, nuts, washers and dowel pins. Besides assembling parts IFX also takes care
of creating holes and counter bores in the parts. As placement reference points, axes or holes
can be used. If desired you can configure IFX to create the holes without external references.

In this training only screw connections are explained. Dowel pin connections work similar.
Read more about dowel pins in the Creo Parametric help.

To prepare the next lessons activate the 1st of the three patterned rectangular beams and
create:

• a datum point feature with two points.
• a through hole with diameter [13mm].

4.2 Assemble fasteners on Points/Axis
To assemble a screw connection with IFX you need to select a datum point, axis or hole as
placement reference, the surface where the screw head shall be placed and the surface where
the nut or thread shall be placed.

As a first example assemble fasteners on datum points.

1. Switch to the Tools Tab in the ribbon to access the IFX functionality.

2. Click Assemble on point or axis.

• The Select References dialog box shows up.
3. Select datum point PNT4 as Position Reference [A].
4. Select the upper surface of the plate [B] as Screw Head Placement Surface.
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5. Select the lower surface of the rectangular beam [C] as Nut/Thread Placement surface.
6. Click [OK] or middle mouse button to get continue.

Hint 12 — Connection types. You can also determine the resulting connection type with the
help of the indication arrows. Opposing arrows will result in Screw/Nut and aligning arrows
in Screw/Thread connection.

The Screw Fastener Definition dialog box for configuring fasteners opens. As the screw
head and nut/thread surface are opposing, IFX assumes that you want to create a fastener
connection with nut. If both surfaces are aligned, IFX assumes that you want to create a
connection with thread. The Screw Fastener Definition dialog box looks like this:
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1. Select catalog
2. Screw standards
3. Select thread and length

• Measure diameter

• Calculate screw length

• Toggle automatic screw length calculation
4. Side 1 washers
5. Side 2 washers
6. Nut standards
7. Toggle 2D-Preview
8. 2D-Preview
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9. Load and save definitions
10. Toggle hole definition
11. Hole definition area

• Hole diameter
• Counterbore options
• Automatic UDF options

To complete the fastener proceed as follows:

1. Select the screw type [ISO 4762 – 8.8].
2. Select screw diameter [M10].
3. Activate 1st washer on nut side and select type [DIN 125-1-A].
4. Select nut type [ISO 4032 - 8].

5. Click to perform a screw length calculation or click to permanently enable
automatic length calculation.

6. Click [OK] to close the dialog.

• As the selected datum point belongs to a feature with multiple points, the Pattern
Options dialog box opens.

7. Check the option [Assemble fastener on all instances?] to assemble the screw
connection on all points of the feature.

• The screw connection is assembled with all components and holes on both points.

Now assemble a screw connection on an axis.

1. Click Assemble on point or axis.
2. Select the axis of the hole created above as placement reference [A].
3. Select the lower surface of the rectangular beam [B] as screw head surface.
4. Select the lower surface of the plate [C] as placement surface for nut/thread.

• As both surfaces have same orientation, IFX assumes that you want to have a
connection with thread. Therefore the nut area in the dialog box is inactive.

5. Select screw type [ISO 4014 - 8.8].
6. Activate option [Through Thread] for the thread hole.
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7. Click to perform a screw length calculation.
8. Click [OK] to close the dialog and assemble the screw connection.

• The screw connection is assembled on the axis with all components and missing holes.

4.3 Reassemble fasteners
Similar to profiles and connector elements existing screw connections can be reassembled.

1. Click Reassemble.
2. Select a component of the screw connection assembled as first connection in the previous

chapter [A].

• The Select References dialog box shows up.
3. Select the datum point PNT4 [B] on the second rectangular beam of the pattern as

placement point.
4. If it is not already preselected select the upper surface of the plate [C] as screw head

surface.
5. If it is not already preselected select the lower surface of the rectangular beam [D] as

surface for the nut.
6. Click [Apply] or middle mouse button to permanently create connection and continue

with creating next connection or click [OK] to permanently create connection and then
quit the process.

• As the new datum point belongs to a feature with multiple points, the Pattern
Options dialog box opens.
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7. Check the option [Assemble fastener on all instances?] to assemble the screw
connection on all points of the feature.

• The screw connection is assembled again using identical configuration (same parts,
same holes).

4.4 Redefine a Screw Connection
Screw connections assembled with IFX can be redefined (however no new references can be
set).

1. Click Redefine.
2. Select a component of the screw connection to redefine [A].

• As the screw connection is reassembled multiple times the Redefine Options dialog
box appears.

3. Check option Redefine all elements and then click [OK].

• The Screw Fastener Definition dialog box for configuring fasteners opens.
4. Select screw type [ISO 4014 - 8.8].
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5. Select screw diameter [M12].
6. Activate check box for [Counterbore] on screw side.

7. Click to perform a screw length calculation.
8. Click [OK] to close the dialog and to redefine the screw connection.

• The screw connection is redefined on all locations. All screws, nuts, washers and
holes are modified and the hole type is changed to counter bore hole.

4.5 Assemble Fasteners by Mouse Click
Besides assembling screw connections on points/axes it is possible to assemble screw
connections by mouse click.

1. Click Assemble by mouse click.

• The Select References dialog box shows up.
2. Select the left side edge of the plate [A] as 1st dimension reference for the screw

connection.
3. Select the upper edge of the plate [B] as 2nd dimension reference for the screw

connection.
4. Select the front surface of the rectangular plate [C] as screw head surface.
5. Select the rear inside surface of the diagonal U-profile [D] as placement surface for the

nut.
6. Click [OK] or middle mouse button to get continue.

• The Screw Fastener Definition dialog box for configuring fasteners opens.
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7. Configure the fastener as shown in the image.
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8. Click [OK] to close the dialog box. Now you can see a preview of the screw connection
on the mouse pointer.

9. Move the mouse to the desired position and click left mouse button.

• The screw connection is assembled. If the mouse pointer is at a position where the
fastener axis does not intersect both surfaces the fastener can not be placed and the
preview has a different color.

10. Move the mouse pointer to a different location and click left mouse button.

• The screw connection is created again.
11. Quit the process with middle mouse button.
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5.1 Overview
AFX offers several functions to simplify creation of drawings and BOMs. This chapter will
address these tools. Before performing the next steps of this training guide in Creo
Parametric model tree load tree configuration file tree.cfg. You can see columns EFX_
ITEM_NR, DESIGNER and CUSTOMER.

5.2 Project Parameters
AFX has two functionalities for handling project specific parameters for AFX parts and
subassemblies:

• Inheriting project parameters (like customer, contract number etc.) from top level
assembly to parts and subassemblies

• Calculation of Item numbers of parts or subassemblies in a project

These functions can be found in the Project parameters dialog box.
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Inherit Parameters
This functionality allows you to inherit project relevant parameters (like customer name,
project number, designer etc.) from top level assembly to all project specific sub components.
To copy the value of top level assembly parameters DESIGNER and CUSTOMER to all
project specific sub components proceed as follows.

1. Click Project Parameters.

• The AFX Project parameters dialog box opens.
2. In Inherit parameter area check the parameters [CUSTOMER] and [DESIGNER] as

parameters to inherit.
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3. Check option [Create the inherit parameter] to create the parameter in the sub
components.

• If you know that the parameters already exist, it is not required to check this option.

4. Click to inherit the parameters.

• In the model tree you can see that the parameters are created in all project specific sub
components.

Calculate Item Numbers
This functionality allows you to calculate item number strings for all sub components of top
level assembly. Item numbers are similar to the repeat index of a Creo Parametric repeat
region but have some advantages compared to them:

• Item numbers are available as model parameters for project specific models therefore they
can be shown on single part drawings or views.

• Identical models can have the same item number even if the model names are different.
AFX can perform a recognition of identical models and will assign the same item number
if this is the case.

• Item number notes can be shown on multiple views for same model.

To perform an item number calculation for the current assembly proceed as follows.
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1. Click Project Parameters.

• The AFX Project parameters dialog box opens.
2. Uncheck option [Same counter for parts/assemblies] to use different counter for parts

and assemblies.
3. Uncheck option [Same counter for standard models] to use different counter for project

specific and catalog models.
4. Enter letter [p] in Prefix/Parts and letter [a] in Prefix/Assemblies input filed.
5. Enter [100] into Count start/Parts input field
6. Enter [1000] into Count start standard/Parts input field.
7. Check option [Same number for identical models] to perform recognition of identical

models.

8. Click to perform a new item number calculation.
9. Accept question Overwrite existing item numbers (y/n)? with [y].

The item number creation is performed. The item numbers are created as component feature
parameters EFX_ITEM_NR and for project specific models additionally as model parameters
EFX_ITEM_NR. You can see that:

• Item numbers for project specific parts have prefix p and start with 100
• Item numbers for catalog parts (like screws, nuts etc.) have prefix p and start with 1000.
• Identical models have the same item number even if the Creo Parametric model name

differs (e.g. the 4 base plates).
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5.3 Creation of BOMs and other reports
Open the drawing steel_frame. AFX supports creation of BOMs using Creo
Parametric repeat region functionality as well as other type of reports typical for beam
structure designs like stock length tables and optimized cut lists.

Creating BOMs
BOM information is added to components automatically, when assembling components with
AFX. In standard configuration the BOM information is in parameters NAMING and
DESIGNATION, however this can be configured (see chapter 8.2). BOM information is
available in the parts as regular parameter, so BOMs can be created using regular repeat
region functionality. In the AFX installation directory sub folder demo you can find a Creo
Parametric table file which fits to standard AFX BOM parameters. If you want to create
BOMs using your own custom tables, you have to customize AFX BOM parameters (see
chapter 8.2) to fit to the parameters of your BOM tables repeat region.

To create a BOM of the assembly with Creo Parametric functionality place the table
profil_bom_english_new.tbl on the drawing.

This table does not show repeat region parameter rtp.index in column Pos but shows
parameter EFX_ITEM_NR created in the previous chapter.
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Place Item number Notes
If parameter EFX_ITEM_NR is shown in BOM instead of repeat region parameter an
automated placement of BOM-balloons using Creo Parametric functionality requires
additional configuration. Therefore AFX provides functionality to easily place item number
notes showing parameter EFX_ITEM_NR. To place notes with parameter EFX_ITEM_NR
proceed as follows.

1. Click Create item number note.
2. Select part for which the note shall be placed [A].
3. Pick location for note [B].

• The note is created. Repeat step 2 and 3 for other parts.

If you want to place BOM Balloons using Creo Parametric functionality proceed as follows.

• Select the BOM table.
• Click and switch to tab BOM Balloons
• Select type custom.
• Click [Browse...] and select AFX_POS.sym in the steel_frame_start folder of this

guide.
• Click [OK] to complete the definition.
It is now possible to place BOM Balloons with the Creo Parametric functionality.

Creation of stock length tables
The Stock length table lists the section type, size and total length required for each profile.
This information is helpful for ordering raw stock material for profile sections.
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To create a stock length table of the assembly proceed as follows.

1. Click Create a stock length table.
2. Pick location for table.

• The table is created as shown in next picture.

Creation of optimized cut lists
Optimized cut lists give information about how many raw material pieces with a standard
length of 6000mm are required for each profile section and size and which part of the design
to cut from which raw material piece to have minimum cut loss.

To create an optimized cut list of the assembly shown on the drawing proceed as follows.

1. Click Create a cut list.
2. Enter number of table columns [4].
3. Pick location for table.
4. Enter whether you want to have separate table for each profile section type and size. In

this case enter [y].

• The table is created as shown in next picture.
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The information in the table is as follows. From section RECTANGULAR TUBE DIN 2395
120x80x4.00 two 6000mm raw material pieces are required. From 1st raw material cut:

• SF_RECTANGULAR_TUBE_1 with length 2080
• SF_RECTANGULAR_TUBE_4 with length 1280
• 3 x SF_RECTANGULAR_TUBE_2 with length 860

From 2nd raw material cut:

• SF_RECTANGULAR_TUBE_1 with length 2080
• SF_RECTANGULAR_TUBE_3 with length 1120
• SF_RECTANGULAR_TUBE_2 with length 860

5.4 Drawing automation tools
AFX supports creation of drawings for profile and plate parts as views on the assembly
drawing as well as separate drawings.

Create profile and plate part views on assembly drawings
AFX offers an easy to use and quick functionality to create profile and plate part views on
assembly drawings.

1. Click Create component views.
2. Answer question Enter detail view scale with [0.2].
3. Select one of the 3 patterned rectangular beams [A].
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4. Pick location for part view [B].

• The views for the profile are created as defined in the drawing_setup.txt file
(see 5.3.4) used for this part.

5. Select one of the 4 corner base plates [C].
6. Pick location for part view [D].

• The views for the plate are created.

Dimension profile and plate part views on assembly drawings
AFX offers an easy to use and quick functionality to automatically dimension profile and
plate part views. The dimension style is typical for simple structural steel parts, like plates and
profiles with holes or simple cutouts. It does not work well for more complex parts. If the
dimension style is not as desired, it can be modified using regular Creo Parametric
functionality. To automatically dimension the profile and plate part views created in previous
chapter

1. Click Dimension the part automatically.

• The Dimension the part automatically dialog box opens.
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2. Check option [Create chain dimensions].
3. Uncheck option [Create accumulative dimensions].
4. Click [OK] to accept the definition.
5. Select view of profile part [A].

• Dimensions for the profile part are created.
6. Select view of plate part [B].

• Dimensions for the plate part are created.

Automatic creation of component drawings
AFX offers functionality to automatically create separate drawings for all profiles, plate parts
and project sub-assemblies belonging to an AFX assembly. Furthermore it is possible to add
dimensions to profiles and plate parts automatically.

To automatically create profile and plate part drawings of all profiles and plates of
steel_frame.asm proceed as follows.

1. Open the main assembly steel_frame.asm.

2. Click Create component drawings.

• The Drawing creation configuration dialog box opens.
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3. Check option [Create part drawings].
4. Uncheck option [Create assembly drawings].
5. Check option [Dimension drawings].
6. Check option [Create chain dimensions].
7. Uncheck option [Create accumulative dimensions].
8. Click [OK] to accept the definition.

• All profile part and plate drawings are created and dimensioned as defined in the
drawing_setup.txt files (see 5.3.4).

Customizing the look of single part views and single part
drawings
The look of single part views and single part drawings created by AFX can be customized in
a file named drawing_setup.txt. As drawing setup usually depends on the type of component
the drawing_setup.txt files are located in AFX library and can be defined for single library
components or library component folders or library component types. The search order for the
drawing_setup.txt file for a specific AFX library component is as follows.

1. File named library_component_name_drawing_setup.txt in library folder
of component, e.g. afx_install_dir/parts/profiles/steel_beams_mm/
i_beam_drawing_setup.txt

2. File named drawing_setup.txt in library folder of component, e.g. afx_
install_dir/parts/profiles/steel_beams_mm/drawing_setup.txt

3. File named drawing_setup.txt in AFX component library type, e.g. afx_
install_dir/parts/profiles/drawing_setup.txt for all profile parts.

The content of a drawing_setup.txt file looks as follows.

DRAWING_FORMAT_NAME efx_a3

GENERAL_VIEW +YZ

TOP_VIEW 1

RIGHT_VIEW 1

BOTTOM_VIEW 1
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DRAWING_FORMAT_NAME means the name of the drawing format to be
used for single part drawing creation.

GENERAL_VIEW means the name of a model view which
shall be used as general (base) view of the
drawing.

TOP_VIEW,
RIGHT_VIEW,

BOTTOM_VIEW,

LEFT_VIEW,

TOP_TOP_VIEW,

BOTTOM_BOTTOM_VIEW

means that a top, bottom, right, left etc. view
of the general view shall be created. The
number controls the distance between views
relative to view size.

When placing the views AFX automatically selects proper drawing scale by choosing from a
list of drawing scales in file

afx_install_dir/configuration/drawing_scale_list.txt. Instead of
defining drawing format and views for the drawing also a drawing template can be used by
line DRAWING_TEMPLATE_NAME.
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6.1 Overview
AFX has an extended library of flat, N-sided plates which allow you to design simple
weldments of flat plates (like shown in next picture) with a top down design process similar to
design of frames with beams:

• Create a skeleton with curves, planar surfaces, points etc.
• Assemble flat plates using the curves, planar surfaces, points etc. as references.
• Define joints for side surfaces of plates if required.

It is possible to combine AFX flat plates with beams and also regular Creo Parametric parts
in one assembly.

AFX flat plate library looks as shown in next picture. You can see plates with different
number of sides which can be placed using lines, points or surfaces as reference.

Open assembly plate_weldment.asm which already contains a skeleton of planar
surfaces, curves, points etc. An AFX project already is defined for this assembly.
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6.2 Plates on curves
To assemble the base plate of the weldment using the 4 edges of the bottom planar surface
proceed as follows.

1. Click New Equipment Elements.

2. Click to open Select from library dialog box.
3. Select [PLATES MM] > [PLATE 4 LINES].

• The Element definition dialog box of the PLATE 4 LINES opens.
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Hint 13 — Tips for plates. You should be careful, when selecting references. Try to
remember what curve you selected first to understand the possible modifications via
the dimensions D_1, D_2, D_3, D_4. Also be sure to select the references in the
correct order (here counter-clockwise) and to configure the Attach option
accordingly. Unfortunately it is not possible to redefine the Attach option later on.
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Now select the lines which determine the size of the plate in counter-clockwise order.
The lines can be edges or curves. It is not possible to mix edges and curves as
references for one plate.

4. As reference Line 1 (1) select the front edge of the lower datum surface [A].
5. As reference Line 2 (2) select the right edge of the lower datum surface [B].
6. As reference Line 3 (3) select the back edge of the lower datum surface [C].
7. As reference Line 4 (4) select the left edge of the lower datum surface [D].
8. Toggle to Settings tab and keep the default values in the dialog.
9. Click [Preview] or middle mouse button to get a preview.
10. Click [OK] or middle mouse button to close the Element definition dialog box.

• The plate is assembled.

Hint 14 — Select all references. As you learned in one of the previous chapters you

can also select all references in a loop. To do so press and select the references
one after another. The required reference will also be displayed in the Creo
Parametric message area.

To assemble the top plate of the weldment using the 4 curves on the top proceed as follows.

1. Click New Equipment Elements.

2. Click to open Select from library dialog box.
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3. Select [PLATES MM] > [PLATE 4 LINES].

• The Element definition dialog box of the PLATE 4 LINES opens.
4. As reference Line 1 (1) select the front edge of the lower datum surface [A].
5. As reference Line 2 (2) select the right edge of the lower datum surface [B].
6. As reference Line 3 (3) select the back edge of the lower datum surface [C].
7. As reference Line 4 (4) select the left edge of the lower datum surface [D].
8. Toggle to Settings tab and keep the default values in the dialog.
9. Enter desired attach option [3] in field Attach option as the plate shall be placed below/

behind the plane defined by the 4 curves.
10. Click [Preview] or middle mouse button to get a preview.
11. Click [OK] or middle mouse button to close the Element definition dialog box.

• The plate is assembled.

To assemble the stiffening plate of the weldment proceed as follows.

1. Click New Equipment Elements.

2. Click to open Select from library dialog box.



Design Assemblies with Flat Plates

Page 99/136

3. Select [PLATES MM] > [PLATE 5 LINES].

• The Element definition dialog box of the PLATE 5 LINES opens.
4. As reference Line 1 (1) select the curve marked with [A].
5. As reference Line 2 (2) select the curve marked with [B].
6. As reference Line 3 (3) select the curve marked with [C].
7. As reference Line 4 (4) select the curve marked with [D].
8. As reference Line 5 (5) select the curve marked with [E].
9. Toggle to Settings tab and keep the default values in the dialog.
10. Enter desired attach option [2] in field Attach option as the plate shall be placed centered

to the plane defined by the 5 curves.
11. Click [Preview] or middle mouse button to get a preview.
12. Click [OK] or middle mouse to close the Element definition dialog box. The plate is

assembled.
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6.3 Plates on points
To assemble the right side plate of the weldment using the 4 datum points on the right side
proceed as follows.

1. Click New Equipment Elements.

2. Click to open Select from library dialog box.
3. Select [PLATES MM] > [PLATE 4 POINTS].

• The Element definition dialog box of the PLATE 4 POINTS opens on References
tab.
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4. As reference Point 1 (1) select datum point APNT1 [A].
5. As reference Point 2 (2) select datum point APNT5 [B].
6. As reference Point 3 (3) select datum point APNT0 [C].
7. As reference Point 4 (4) select datum point APNT4 [D].
8. Toggle to Settings tab.
9. Enter offset values [-10] in D_2 and D_4 to have some space for weldment lines.
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10. Enter desired attach option [3] in field Attach option.

Hint 15 — Attach Options. The points you select as references in counterclockwise
sense form a plane. Attach option 1 means in front of this plane, 2 means centered to this
plane, 3 means behind this plane.

11. Click [Preview] or middle mouse button to get a preview.
12. Click [OK] or middle mouse button to close the Element Definition dialog box.

• The plate is assembled.

To assemble the right side plate again on the left side of the weldment using the 4 datum
points on the left side.

1. Click Reuse.
2. Select the plate assembled before [A] as element you want to assemble again.

• The Element definition dialog box of the PLATE 4 POINTS opens on References
tab.

3. As reference Point 1 (1) select datum point APNT3 [B].
4. As reference Point 2 (2) select datum point APNT7 [C].
5. As reference Point 3 (3) select datum point APNT6 [D].
6. As reference Point 4 (4) select datum point APNT2 [E].
7. Toggle to Settings tab.
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8. Enter desired attach option [1] in field Attach option to place the plate in front of the
plane defined by the 4 points in counterclockwise sense.

9. Click [Preview] or middle mouse button to get a preview.
10. Click [OK] or middle mouse button to close the Element Definition dialog box.

• The plate is assembled.

6.4 Plates on planar
To assemble the center plate of the weldment using the 4 side surfaces of bottom, right, top
and left plate.

1. Click to open Select from library dialog box.
2. Select [PLATES MM] > [PLATE 4 PLANES].

• The Element definition dialog box of the PLATE 4 PLANES opens on
References tab.
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Now select the planar surfaces which determine the size of the plate in
counterclockwise sense.

3. As reference Plane 1 (1) select upper surface of bottom plate [A].
4. As reference Plane 2 (2) select left surface of right plate [B].
5. As reference Plane 3 (3) select lower surface of top plate [C].



Design Assemblies with Flat Plates

Page 105/136

6. As reference Plane 4 (4) select right surface of left plate [D].
7. As reference Attachment plane (5) and select datum plane [E].
8. Toggle to Settings tab.
9. Enter desired attach option [2] in field Attach option.
10. Click [Preview] or middle mouse button to get a preview.
11. Click [OK]or middle mouse button to close the Element definition dialog box.

• The plate is assembled.

6.5 Plate Joints
As you can see at the current state of the model the plates interfere as the planes, curves and
points of the skeleton did not consider plate thickness. This can be solved by creating a
replace surface joint. It works similar to the to selected surface joint for profiles.

To create regular replace surface joints for the 5-sided stiffening plate proceed as follows:

1. Open the Advanced Joints dialog box.

2. Click to create regular replace surface joints without offset.
3. Select the lower surface of the 5-sided stiffening plate as Surface to replace [A].
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4. Select the upper surface of the bottom plate as Attachment surface [B].

• The side surface of the 5-sided plate is attached to the upper surface of the lower plate.
5. Click [Repeat] or middle mouse button to complete joint creation and continue with next

joint.
6. Select the back surface of the 5-sided stiffening plate as Surface to replace [C].
7. Select the front surface of the center plate as attachment surface [D].

• The side surface of the 5-sided plate is attached to the front surface of the center plate.
8. Click [OK] to complete joint creation and close dialog box.

In some cases a plate side surface shall not be attached directly to another surface, but it shall
remain perpendicular to the plates plane and only cut along an intersection line of the plate
surface and the attachment surface. The lower and upper side surface of the right plate is an
example for this.

To create a Replace Surface joint normal to selected surface along intersection line for the
right side plate proceed as follows.

1. Open the Advanced Joints dialog box.

2. Click to create a Replace Surface joint normal to selected surface along
intersection line.

3. Select the lower surface of the right side plate as Surface to replace [A].
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4. Select the upper surface of the bottom plate as Attachment surface [B].
5. Select left surface of the right side plate [C] as Planar surface to determine intersection

line with attachment surface.
6. Click [Repeat] or middle mouse button to complete joint creation and continue with next

joint.

The lower surface of the right side plate is attached to the upper surface of the lower plate
however it still is perpendicular to the plates plane.

Hint 16 — Delete Replace surface joints. To delete a replace surface joint press and
select the surface that has been modified by the joint definition. In this case the selected
surface [A].

Continue with the joint definition on the upper side of the assembly.

1. Select the upper surface of the right side plate as surface to replace [A].
2. Select the lower surface of the top plate as attachment surface [B].
3. Select right surface of the right side plate [C] as surface to determine intersection line

with attachment surface.
4. Click [OK] to complete joint creation and close dialog box.

The upper surface of the right side plate is attached to the lower surface of the upper plate
however it still is perpendicular to the plates plane. As the right plate is assembled as identical
model on the left side of the assembly, the modifications also appear on left side.
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7.1 Overview
Besides profiles and components for steel construction, the AFX library contains many
profiles and components of different aluminum profile systems (e.g. Bosch, Item, etc.). In this
chapter, a simple framework using Item profiles will be created.

1. Open the assembly alu_frame.asm.

• The reference curves for the frame already are created.

2. Press Create new project and enter [af] as project shortcut.

7.2 Aluminium profiles
Assembling aluminum profiles using AFX is similar to steel beams, but it is not necessary to
choose standard and size. The profile is directly chosen in the library dialog box. In this
example some Item profiles 8 80x40, then some profiles 40x40, and finally a cover profile 8
32x4 will be assembled to the frame.

1. Click to open the Profiles dialogbox.

2. Click and select [ITEM] > [profiles_8] > [8_def].
3. Select profile [p_8_80x40].
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4. Select the reference curves [A], [B] and [C]. Rotate the profiles if necessary.

• A new profile is assembled on each curve.
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Keep the previously selected profile active and proceed as follows.

1. Select reference curve [A].

• A new profile is assembled.

On the remaining curves, profiles 8 40x40 will be assembled.

1. Click to open the Select from library dialog box.
2. Select profile [p_8_40x40] from folder [ITEM] > [profiles_8] > [8_def].
3. Select the reference curves [A], [B], [C] and [D].
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• A new profile is assembled on each curve.

As aluminum profile systems sometimes have profiles that are assembled into the slots of
other system profiles, these system profiles have predefined curves at the slots that can be
used to assemble other profiles.

To use slot curves as reference for other profiles proceed as follows.

1. Show layer 00_PROFIL_SLOT_CURVE.

• The location of slots will become visible on the profiles

2. Click to open the Profiles dialog box.

3. Click and select [ITEM] > [profiles_8] > [misc].
4. Select profile [cover_profile_8_32x4].
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5. Select the upper surface of the horizontal profile as orientation plane [A].
6. Select the profile slot reference curve [B].

• The cover profile is assembled.

Hint 17 — Simplified representation of aluminum profiles. The aluminum profiles are
assembled in simplified representation by default. If desired they can be shown in a more
detailed representation (see chapter 7.5).

Now, create the joints between the profiles like shown in the next picture. Do not apply a joint
to the diagonal profile yet. This will be done later on.

For this task you will need the following joints.

• Corner Joint

• T-joint
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7.3 Connector elements
Assembling connector elements for aluminum profile systems using AFX works like
described in chapter 3.

Unlike steel profile connections this connector elements usually have no configuration
options since most connector and equipment elements are not variable in size and do not have
different assembling options. The necessary selections for the element are shown in the
Connector Elements dialog box. Using some parts of the item system, the procedure is
demonstrated, connector and equipment elements of other vendors work similar.

To open the New Connector Elements dialog box click New Connector Elements.
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Universal connectors
To assemble an Item universal connector proceed as follows.

1. Click and select [ITEM] > [connector_sets] > [universal_connector] > [uc_8].

• The Element definition dialog box of the uc_8 opens. The required pick references
are shown in the picture. If a profile has multiple slots you must choose the
approximate location. AFX will use the closest slot according to your selection.

2. As reference ASSEMBLY-POSITION select the lower left profile at the left assembling
position [A] of the connector element.

• The universal connector is assembled and the necessary bore is created in the profile.
3. Click [OK] or middle mouse to close the Element definition dialog box.
4. Click [Next] or middle mouse in New Component dialog box to assemble connector

again.
5. As reference ASSEMBLY-POSITION select the profile at the right assembling position

[B] of the connector element.

• The universal connector is assembled and a bore is created in the profile.
6. Click [OK] or middle mouse to close the Element definition dialog box.
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Creation of optimized cut lists
Unlike the universal connector the angle bracket needs two references. Assemble the element
as follows.

1. Click and select [ITEM] > [bracket_connectors] > [brack_set_8_40x40].

• The Element definition dialog box of the brack_set_8_40x40 opens. The required
pick references are shown in the picture.

2. As reference ASSEMBLY-POSITION1 select the left surface of the right vertical profile
[A].

3. As reference ASSEMBLY-POSITION12 select the upper surface of the bottom right
profile [B].

• The bracket connectors is assembled.
4. Click [OK] or middle mouse to close the Element definition dialog box.
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In the next step we will assemble another bracket connector. This one can be used to attach
the diagonal profile. Assemble the element as follows.

1. Click and select [ITEM] > [bracket_connectors] > [brack_element_8_t1_40].

• The Element definition dialog box of the brack_element_8_t1_40 opens. The
required pick references are shown in the picture.

2. As reference PROFILE END select the diagonal profile near the end [A].
3. As reference ATTACH PLANE select the lower right profile at the upper surface [B].

• The bracket connectors is assembled.
4. Click [OK] or middle mouse to close the Element definition dialog box.
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Joints
In this section a joint will be assembled. When you use this component AFX will
automatically measure the required angle and create a new instance. Assemble the element as
follows.

1. Click and select [ITEM] > [joints] > [joint_8_40x40_flex].

• The Element definition dialog box of the joint_8_40x40_flex opens. The required
pick references are shown in the picture.

2. As reference PROFILE_1_BORE_AXIS select the axis of the diagonal profile [A].
3. As reference PROFILE_2_BORE_AXIS_OR_ATTACH_FACE select the right vertical

profile at the left surface [B].
4. As reference PROFILE_SIDE_FACE select the right vertical profile at the front surface

[C].

• The joint is assembled and the profile is shortened.
5. Click [OK] or middle mouse to close the Element definition dialog box.
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7.4 Equipment elements
Assembling equipment elements for aluminum profile systems with AFX works similar to
connector elements. To open the New Equipment Elements dialog box click New
Equipment Elements.

Profile end caps
To assemble profile end caps proceed as follows.

1. Click and select [ITEM] > [caps] > [caps_8] > [cap_8_80x40].

• The Element definition dialog box of the cap_8_80x40 opens. The required pick
references are shown in the picture.

2. As reference PROFILE-END select the upper horizontal profile close to the left end [A].

• The cap is assembled.
3. Click [OK] or middle mouse to close the Element definition dialog box.
4. Click [Next] or middle mouse in New Component dialog box to assemble connector

again.
5. As reference PROFILE-END select the upper horizontal profile close to the right end

[B].

• The cap is assembled again.
6. Click [OK] or middle mouse to close the Element definition dialog box.
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Transport and foot plates
To assemble transport and footplates proceed as follows.

1. Click and select [ITEM] > [transport_foot_plates] > [transport_footplates_8] >
[tf_pl_8_80x40_m10].

• The Element definition dialog box of the tf_pl_8_80x40_m10 opens. The required
pick references are shown in the picture.

2. As reference PROFILE-END select the right vertical profile close to the lower end [A].

• The plate is assembled with screws and the threads are created in the profile.
3. Click [OK] or middle mouse to close the Element definition dialog box.
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Feet
To assemble transport and footplates proceed as follows.

1. Click and select [ITEM] > [feet] > [foot_d40_m8x60].

• The Element definition dialog box of the foot_d40_m8x60 opens. The required pick
references are shown in the picture.

2. As reference PROFILE BORE AXIS select the bore axis of the middle vertical profile
close to the lower end [A].

• The foot is assembled and the thread is created in the profile.
3. Click [OK] or middle mouse to close the Element definition dialog box.
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Now assemble another foot on the previously assembled transport and footplate.

1. Click and select [ITEM] > [feet] > [foot_d40_m10x80].
2. As reference PROFILE BORE AXIS select as [PROFILE BORE AXIS] the axis of the

middle bore of the foot plate that was assembled in the previous chapter [A].

• Since the axis does not belong to a profile, AFX can’t find the proper profile end
surface. Therefore you are prompted to select the PROFILE END SURFACE

3. Select the bottom side of the plate [B].

• The foot is assembled.
4. Click [OK] or middle mouse to close the Element definition dialog box.
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Plate elements
To assemble Item plate elements proceed as follows.

1. Click and select [ITEM] > [plate_elements] > [polycarbonat].

• The Element definition dialog box opens on References tab.
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2. As reference Left plane (1) select the right side surface of the left vertical profile [A].
3. As reference Right plane (2) select the left side surface of the right vertical profile [B].
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4. As reference Bottom plane (3) select the upper surface of the down horizontal profile
[C].

5. As reference Top plane (4)] select the lower surface of the upper horizontal profile [D].
6. As reference Attachment plane (5) select the rear surface of the lower horizontal profile

[E].
7. Toggle to the Settings tab.
8. Enter Attach option [C] to place the plate aligned to the attach face (A = on the surface,

B = in the middle).
9. Select type [polycarbonat 8mm, clear] from the table.
10. Enter the desired offset values [-5] into the four fields OFF_LEFT (offset at the left),

OFF_RIGHT (offset at the right), OFF_BOTTOM (offset at the bottom), OFF_TOP
(offset at the top).

11. Click [Preview] or middle mouse button to get a preview.
12. Click [OK] or middle mouse button to close the Element definition dialog box.

• The plate is assembled.

Multi blocks
To assemble multi blocks proceed as follows.

1. Click and select [ITEM] > [multi_blocks ] > [multi_block_8_zn].

• The Element definition dialog box of themulti_block_8_zn opens. The required
pick references are shown in the picture. In the message area you will be prompted to
select PLACEMENT PLANE_PROFILE, PLACEMENT_PLANE_SURFACE_
ELEMENT and DISTANCE_PLANE.
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2. As reference PLACEMENT_PLANE_PROFILE select the upper surface of the lower,
horizontal profile [A].

3. As reference PLANE_SURFACE_ELEMENT select the surface of the poly-carbonate
plate [B].

4. As reference DISTANCE_PLANE select the right surface of the left, vertical profile [C].
5. Toggle to the Settings tab.
6. Enter as DISTANCE [100].
7. Click [Preview] or middle mouse button to get a preview.
8. Click [OK] or middle mouse button to close the Element definition dialog box.

• The multi block is assembled.
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7.5 Simplified representation
As you might have realized, the profiles are not in a very high level of detail. This an intended
behavior to reduce regeneration and retrieving time of the assembly. This technique also
allows you to create huge assemblies without slowing the system down.

AFX comes with automatic simplified representations. To switch between different levels of
quality open the Simplified Representations dialog box.

In the dialog you have the following possibilities.

• Change the level of detail for the entire assembly
• Change the level of detail for selected components
• Change the level of detail for screws and pins

Each of these groups has three different levels of detail. The first option is the default value. If
you change the settings all new assembled profiles will be assembled in the level you
previously chose.

Press to show the assembly in full detailed level.
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8.1 Overview
This chapter will give you a quick information about the AFX configuration. It is possible to
configure BOM Parameters, the AFX part naming scheme and allows you to configure the
start model.

8.2 BOM Parameters
Each profile assembled with AFX has six system parameters by default. All other AFX
elements have three system parameters by default. These parameters are either stored as fixed
values in parameters of the profiles or elements or they are controlled by AFX during
assembly of the profile or element or during regeneration of the complete assembly:

1. BUW_NAME - Contains the name of the profile or element, such as angle, pipe, or end
plate. This value is stored as a fixed value in the profile, connector or equipment element
and is not changed.

2. BUW_TYPE - Contains a description of the type of profile or element, for example,
supplier and ordering number of elements from aluminum profile systems. This value is
also stored as a fixed value in the library parts and is not changed.

3. BUW_SIZE - Contains the size information for the profile or element, such as L4x4x1/2
for an angle, or extra strong 3 for a pipe. The value is either saved as a fixed value in the
library part or it is controlled by AFX if during selection of the element a list with the
different sizes appears.

4. BUW_LENGTH - Contains the cutting length of a profile, rendered a as number. This
value is adjusted after regeneration.

5. BUW_LENGTH_STR - Contains the cutting length of a profile, rendered as text. This
value is adjusted after regeneration.

6. BUW_PROFIL_TYPE - Contains the part name of a profile in the library. This value
may not be changed.

You can create your own BOM parameters from these basic system parameters using Creo
Parametric relations. Write the required relations in a text file named parameter_
relations.txt. The relations in this file are added to the profile or element during the
assembly process so that the part has the required parameters as a combination of the values
of the six system parameters. The following example describes this process using the standard
relation file for profiles (param_relations.txt in sub directory parts/profiles):

NAMING = BUW_NAME

DESIGNATION = BUW_TYPE + " " + BUW_SIZE + " x " + BUW_LENGTH_STR

LENGTH = BUW_LENGTH

During the assembly process, the contents of the parameters are translated and the relation file
is added, so the following BOM parameters appear in the part:

NAMING = "ANGLE"

DESCRIPTION = "L"+" "+"4 x 4 x 1/2"+" x "+"50"="L 4 x 4 x 1/2 x 50"

LENGTH = 50
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AFX uses the following rule when adding relation files:

• If a file named param_relations.txt in the sub-directory of the library from which
the profile or element is retrieved exists, this param_relations.txt is added to the
part.

• If a file named param_relations.txt in the sub-directory of the library from which
the profile or element is retrieved does not exist, the default param_relations.txt
from the library parts/profiles for profiles, from the library parts/bend_profiles for bent
profiles, from the library parts/connectors for connectors, and from the library parts/
equipment for equipment is added.

For screws, washers and nuts the file param_relations.txt is located in parts/ifx_
fastener_data:

You can configure the parameters and their contents in the default param_relations.
txt and in the profile or element specific param_relations.txt in the various sub-
directories, according to your needs.

8.3 Component Naming Scheme
For standard configuration, AFX names components using the following naming scheme:

<PROJECT_SHORT>_<ELEMENT_NAME>_<ELEMENT_NUMBER>

You can overwrite this standard configuration for individual component sub-directories in the
library or globally for each of the component groups (profiles, bend_profiles, connectors, and
equipment). Create a file named element_name.txt in the desired folder (e.g. profiles) and
describe your own naming scheme using the following principles. The element name can be
composed by the following components:

<PROJECT_SHORT> - Project shortcut

<ELEMENT_NAME> - Element name in the library

<ELEMENT_NUMBER> - Incremental number of the element in the current assembly

Arbitrary intermediate text elements #. For example, the default naming scheme in AFX can
be described by the following formatdescribing line in the file element_name.txt:

PROJECT_SHORT#_#ELEMENT_NAME#_#ELEMENT_NUMBER

When AFX composes an element name with this scheme, PROJECT_SHORT, ELEMENT_
NAME,and ELEMENT_NUMBER are replaced with the current values. The _ are intermediate
texts and are kept.

To generate file-names via Windchill number-generator write the following:

WINDCHILL_AUTONUMBER



8.4 Start part configuration

Page 132/136

8.4 Start part configuration
All components in the AFX library are based on the same start part or start assembly. This
start part or assembly may be different from the one you like to use. In order to match AFX
components with your start part or assembly requirements you have the following
possibilities:

• Rename datum planes and coordinate system features in the AFX library components to
your desired names

• Add parameters to AFX library components, give them default values and designate them
to Windchill

• Create layers in the AFX library components
• Create views in the AFX library components
• Change the accuracy type and value
• Change the tolerance type for dimensions

You can define these actions in a file named start_mdl.cfg in the AFX configuration
directory. In standard installation of AFX you will find a template for this start_mdl.
cfg. The template file is named _start_mdl.cfg (see below). If you remove the _at the
beginning of the file name, the modifications in the AFX components will be performed.

NOTE: The start_mdl.cfg configuration will only apply to NEW components!

The syntax for the different modifications is as follows (lines which begin with ! are
comments):

!FEATURE NAMES OF STANDARD FEATURES

FEATURE_NAME XY START_XY

FEATURE_NAME XZ START_XZ

FEATURE_NAME YZ START_YZ

FEATURE_NAME CS0 START_CSYS

FEATURE_NAME A_XY A_START_XY

FEATURE_NAME A_XZ A_START_XZ

FEATURE_NAME A_YZ A_START_YZ

FEATURE_NAME ACS0 A_START_CSYS

!VIEWs TO CREATE OR TO MODIFY

CREATE_VIEW TEST_VIEW

1 1 0

-1 1 0

0 0 1

!PARAMETERS TO CREATE

CREATE_PARAMETER TEST_INT_PARAM INTEGER 17

CREATE_PARAMETER TEST_DOUBLE_PARAM DOUBLE 17.0

CREATE_PARAMETER TEST_STRING_PARAM STRING XYZ
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!LAYERS TO CREATE

CREATE_LAYER TEST NORMAL

CREATE_LAYER MY_DTM_PLANE BLANK DATUM_PLANE

!SET MODEL ACCURACY SET_ACCURACY ABSOLUT 0.01

!SET DEFAULT TOLERANCE TYPE

SET_DEFAULT_TOL_TYPE DEFAULT

Rename Features
A line with the following syntax will rename one of the standard features:

FEATURE_NAME <original feature name> <new feature name>

The original feature names are:

• XY, XZ, YZ for the three default datum planes in parts
• CS0 for the standard coordinate system in parts
• A_XY, A_XZ, A_YZ for the three default datum planes in assemblies
• ACS0 for the standard coordinate system in assemblies
• The new feature name is user defined

Create Parameters
A line with the following syntax will create a parameter in the part or assembly:

CREATE_PARAMETER <parameter name> <parameter type> <default value>
DESIGNATE

Explanation:

• parameter name is the name of the parameter to create.
• parameter type is the data type of the parameter. Valid types are INTEGER, DOUBLE

and STRING.
• As default value you can write an INTEGER number, a DOUBLE number or a STRING

as default value for the parameter.
• The string DESIGNATE at the end of the line is optional. If it exists then the created

parameter will be designated toWindchill.

Create Rule Layers and Combined States
In order to work with rule based layers and combined states you will need to set the following
options:

CREATE_RULE_LAYER_PARAM YES

DELETE_LAYER ALL

RULE_LAYER_TEMPLATE afx_start_model

They have the following effect:
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CREATE_RULE_LAYER_PARAM: All features will receive a parameter that makes the rule
layer template easier to configure

DELETE_LAYER ALL: Deletes all existing layers from the model

RULE_LAYER_TEMPLATE afx_start_model: Copy all layers and combined states from the
afx_start_model.

You can find a good example in the folder afx/configuration/buw_start_configuration_
example

Manage Views
Create Views:

A block with the following syntax will create a view in the part or assembly:

• CREATE_VIEW <view name>

• trans_matrix[0][0] trans_matrix[0][1] trans_matrix[0][2]

• trans_matrix[1][0] trans_matrix[1][1] trans_matrix[1][2]

• trans_matrix[2][0] trans_matrix[2][1] trans_matrix[2][2]

Explanation:

• View name is the name of the view to create.
• trans_matr[i][j] are the numbers in the transformation matrix from model default

coordinate system to the coordinates of the view to create.

You can get the matrix by the following steps:

1. Create an empty part or assembly.

2. Create a coordinate system. It will represent the model default coordinate system.
3. If needed create additional features for orientation.
4. Orient model with Creo Parametric view manager functions.

5. Create a coordinate system using the default coordinate system as reference and
using the option Set Z Normal To Screen

6. Obtain the transformation from this coordinate system to default coordinate system by
using the [Analysis] > [Measure] function of Creo Parametric and choose type
Transform. This function gives you a transformation matrix. You have to enter these
values as trans_matr[i][j] in the view creation block.

Rename Views:

Use the following syntax to rename existing views:

• RENAME_VIEW +XY FRONT
• RENAME_VIEW -XY BACK
• RENAME_VIEW -XZ BOTTOM
• RENAME_VIEW -YZ LEFT
• RENAME_VIEW +YZ RIGHT
• RENAME_VIEW +XZ TOP
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Change model accuracy
A block with the following syntax will change the default accuracy:

SET_ACCURACY <type> <value>

Explanation:

• type the type can be set to RELATIVE or ABSOLUT
• value is a double value (e.g. 0.01).

Change the tolerance type for dimensions
A block with the following syntax will change the tolerance type for dimensions:

SET_DEFAULT_TOL_TYPE

Explanation:

type the type can be set to LIMITS, NORMAL or PLUS_MINUS
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